Project Navigator

==l
Site: |1 =
Froject Tree | D |

= WI=fE probesubsites
- f—é InitializationSteps
WI[E] proberirit
- W] S Subsitel
- -IE:- Aterminal-n-fet
W[ probercortact
WI[E] connect
[ JF wdsid1x <

www.keithley.com

Navigating Multiple ITMs

Vds-id ITM Window

- WL Fteminal-npn-bit
@ connect
2= o [ M—
WI[E] proberssmove
= W1 Subsite?
= WHEE dteminal-n-fet
WI[E€) prober-contact
WI[E] conrect
W] [F ws-id-2n €——
-1 Wl 3terminal-npn-bit
WI[E] conrect
W M weoedic-2y €—
WI[E) proberss-move
- -—L=H-1: TerminationSteps
@ prober-separate
[WI[E] prober-prompt

—l—‘DM—ly(—lmNMD—l—lm—l-*—‘—l—‘D—lDD

N = Projectyiew

Definition ]Sheet ] Graph] Status }:
{Famuiator § Timing | Ezit Conditions | Output Y alues | Speed: ’m Mnde:’—_|
Drrain ’m
FORCE MEASURE |
Sweep 'V [Master] Measure | YES
Type: Linear Ltdduta: 1e-0104
Start: 0 Measure ¥ YES
Stop: 5 Range %: Best Fixed
Step: 014 Compl: 0.14
H Paints: &1
Action
Gate SMU3 Bulk. GNDU «
FORCE MEASURE | FORCE MEASURE |
- Step V¥ [Master) Measure |: MO Common: O Measure | = NA
Double-Click dma [, ]
. Step: 14 Compl: 014
to open vds-id
ITM . Source SMUT -
FORCE MEASURE |
H Bias V. OV M I:NO
VdS—ld ITM = Measuio V: NO
Compl: 0.14
Window Tab ~
N
& ws-idf1 @1
A

Open more ITMs to
add ITM Window
tabs in this area. —

KEITHLEY
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To summarize, click an ITM
Window tab to access the
Definition, Sheet, Graph and
Status tabs for the test.

0
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Executing Project Plans and Tests

Checkboxes

* YOu can execute an entire

Project Plan or individual parts s
of the Project Plan. Site: L

|- [w|=fF default
= ﬁ subsite

2 WHE dteminal-nfet

* Each part of the Project Plan W vdsid

[w] wilif
has a checkbox. A check mark iﬁ o

Indicates that the test is Jlg .

[w] erminal-npn. .
enabled. Checkbox f.% ey

W LE gummel
W F wosat
= [ Ay Zovireresiztor

e The absence of a check mark VIE resat
. . . . - W I+ diode
indicates the test is disabled. I

W] LE wrd

—|- | & capacitar

W F cap

» Clicking on the checkbox adds
or removes the check mark.

KEITHLEY
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Executing Project Plans and Tests

Project Plan: default
| x|  To execute an entire project, select the project node at
Site: |1 h fth ] ) | hi h
o E —— the top of the project navigator. In this case, the
= MFE subsite “default” project node is selected.
- WHE 4termlna!-n-fet
L v « If you select a node other than the project node, KITE

runs only the test or the test sequences at the node.

« To start execution, click on the green triangular Run
> | icon, select Run in the Run menu, or press the F6
1 keyboard key.

» Clicking on the Run button from the project level will
execute everything in the project that is checked —
P « Subsite Plans, Device Plans, ITMs, and UTMs —in the

order in which they appear.

 To abort a test, click on the square red Abort button or
press the Pause/Break keyboard key.

KEITHLEY
2
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Executing Test Sequences and Individual Tests

« To execute an entire Subsite Plan, click on the Subsite
Site: [i J|:|J/ Plan and then click on the green Run button.
= =-§ def <

: %M# Everything located beneath the Subsite Plan that is
- WHE dteminaniet A checked will execute in the order it appears.
J{ﬁ :Sf{'d Device Plan
Sl v
Elf as  To execute all the tests " JI:IJ
- Erminal-npr... . ie.
WILE vesic >_ under a Device Plan that ~ oo
| LF  gurmel . = i -
IE vesal are checked, click on the m
T E"";f;‘“” Device Plan and click Run. WILE vdsid
—|- [ 44 diode JE :ﬂ:vt
| JF wfd W F wgsid
| ok  If you want to execute an OIE igva
viE ||/ individual ITM or UTM, click | |
on only that test and then \
click on the Run button. Site: [i =
Subsite Plan \%E%?‘ét
- dterminal-n-fet
KEITHLEY _
W] i wotlin
A GREATER MEASURE OF CONFIDENCE ES“':"‘_“I
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Message Area of KITE Window

 The Message Area displays
KITE execution and error
messages.

 This area also includes start
time, stop time and total
execution time.

 From the View Menu, the
Project Messages can be
displayed or hidden.

Message Area —

& default - Keithley Interactive Test Environment - [cap#1@ 1]
LE File Wiew Froject Run Tooks Window Help

Interactive Test Module: cap B mE | @ H@ x| - |2 @ @
x|

skl Definition | Sheet | Graph | Status |

= o defaukt

= MIZE subsite

= WIHE dterminalndet
WILE vdsid
W1 LE wHlin
WILE subwt
WIE vosid
L igva

= W4 3teminalnpn
VILE veeic
W LE qummel
WILE vesat

=1 Wy 2owireresistor
W LE res2t

= Mt diode
W L v
W LE vd

= M4 capacitor

¥ ET

Formulator Timing ‘ EmtEundlllons| UutputValues|5peed Mormal ~ | Maode: | Sampling ¥

A SMLIT v 8 SMU2 +
FORCE MEASURE | FORCE MEASLIRE |
Bias |: 3-0114 MeasLre I: NO BiasV: OV Measure |: MO
Measure W YES Measure W ND
Range : Best Fixed Compl: 014

" ofE Projectvisw

Lk dteminabnfel| < defaut | subsitet0@ [ [ vasidt1@1 [JE i@ JE  capian

' start

%2006-12-27 — 12:56:53:
212006-12-27 - 12:57:10:
20061227 — 12:57:10:

Exscution Started
Stop Emscution: cap#l®l
Total Exscution Time: 00:00:00:17

3 default - Keithley ...

KEITHLEY

A . GREATER MEASURE OF CONFIDENCE

4

© Copyright 2004 Keithley Instruments, Inc.



www.keithley.com

Building a New Project

Define a New Project

1. In the File menu, click New Project 2. Name the project (e.g., u_build)

3. Add placeholders for initialization

i — and termination steps (UTMs)

Environment
H
Elaé Project Mame

m}r_i Initialization Steps
El 2 SubSie 1

@ UTM Mumber of Sites: 1 3:

Location:

C:\S4200\kiuser\Projects _|

Project Navigator

Biestore Default Localion:

JEiIE Wiew Project Bun Tool: Help

J Project Plan: u_build

gl -1

A Device 2
# 3 SubSite 2
ﬁ]-:__‘{ Termination Steps

= Project Flan Initialization Steps

£ Off Lo

Site: |5

Create Project with

Temmination Steps

i Initialization snd \— Project Flan Termination Steps— Froject Tree I LD I

0 & On E‘“E u_build 1
I

=5 = T :
4. Click OK ﬁ
KEITHLEY

5
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Building a New Project

Inserting a Subsite Plan & a Device Plan

1. Inthe Project Navigator, click Initialization Steps to indicate the position

for inserting plans. 3. Type in name of Subsite

) subsite a Subsite
2. Click Subsite Plan and click OK —

Plan inserted:

Pl - e upsie lan o Frojec!
an icon rrr——
l Jsubsite_a : x]
A ) Beforeselested node & After selected node |:> Site: |5 I Ijl
> Project Tree UiD
JJ SE 45 U (5] o | Concel | 5o u_buid 0
----- f.-é InitializationS teps a
----- % subsite_a 0
. Loz TeminationSteps i
5. Select 4terminal-n-fet
Plan icon e Device : :
4terminal-n-fet Device
A j . .
— Plan inserted:
|| £ B
Project Tree | [} |
=-=f8 u_buid 0
I:> }é InitislizationS teps 0
Eﬁ subsite_a 1]
A | dteminaln-fet 1
Mew Device Mame:
|4terminal-n-fet
" Before selected node & After selected node
Ok Lancel 6
© Copyright 2004 Keithley Instruments, Inc.
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Building a New Project
Inserting an ITM

1. In the Project Navigator, double-click 4terminal-n-fet to open the Device
Plan window:

% 2. Select vds-id ITM from the
Test :Iam.e o IC:.SQDU\kiuser\Tests =l // I I b r ary.

Click Copy to add ITM to the
Test Sequence Table.

Click Apply to insert ITM.

J

- i | Froject Tree | o |
kiave Dovir Submit Az >>| E‘“g u_build 0
}é InitiaizationSteps 1]
Eﬁ subgite_a 0
21K dteminalndet 1
Tt dleminabnfel ﬁ wds-id 1

KEITHLEY
7
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Building a New Project

Opening an ITM

1. Click on the vds-id ITM in the Project
Navigator.

2. Connect the demo MOSFET to the 4200
as previously described in Slide 58.

3. Click on the graph tab and then click on
the green Run button.

4. Aretheresults as expected?

KEITHLEY
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Building a New Project

Adding ITMs

- [2]X]

evice Plon: Atorminabefet B e (x|« 7| sen | [E)
In the Project Navigator,
double click 4terminal-n-fet. S ||| wo'x| | Fomes =
o 2, Torsamiorn o Tl |EE=
Add more ITMs by clicking ::';; HIFES.
on the MOSFET folder in the e
. JE subwt
Test Library. oot
1 vosid
Select vgs-id and then click g
on Copy. o
Select vtlin and then click on
C O p y- Move Down Subrit As 3> << CopyAs
. Include Data ¥ %
Select subvt and then click N —
on CO py. "Trstart | ubuid-Keitley ..

You can change the execution order of the ITMs by clicking on the
Move Up and Move Down buttons. Click on Move Up two times to
change the order of the 4 ITMs as shown.

Click on Apply. Notice the 4 ITMS in the Project Navigator.

9
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Building a New Project

Executing Multiple ITMs

= u-build - Keithley Interactive Test Environment - [subvt#1@ 1]
U File Wiew Project Run Tools Window Help

_ [ineracive Tost Moo s | RE =L -SE IR = 3 |
1. Click on each ITM and e — e

. . - = wbuid D4/23/2001 17:32:42 [KEITHLEY]
click on their Graph M3 Initeeationsteps VOGS TrMOSFET SubThreshold Voltage Sweep. ... ... . MEHRES

|- M 3E subsite_a o
= MHE dterminaln-fet

WILE wtin
WIHE subwt
T .
1_7‘1.1 TeminationSteps

1.0E-DSE- N A PP S S S

of the KITE window,
there are five tabs.

When an item from the mméﬁﬁﬁﬁfffffﬁﬁﬁﬁffffﬁﬁﬁﬁfffffﬁﬁﬁffff_ﬁﬁffféfffffffff
Project Navigator is
opened, a tab for that - B O

item will appear. g 2 g Z g
FHEDE 1™ G ot )

Sub-Threshold Voltage Slope (45 b=+1.53e+001 .

& 1(+6.002-001. +1.66e-010,20)
Diata SUBVTSLP = 1.53738+001 1/b=+6.54e-002 M2+

50e+000. +1.02e-004, 12)

=m

T f i:.kﬂltermlnal-n-letJﬁ wds-idH &1 “& wgsidHl @1 “& i@ JE  subvil @1
=]

‘s start & u-build - Keithley L.

KEITHLEY
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Building a New Project

Executing Multiple ITMs

. Double click on the Device Plan, 4terminal-n-fet. Close out this
window by clicking on the small gray “x” near the upper right
hand corner. There should now be only the 4 ITMs shown at the
bottom of the KITE window.

. Go up to the Windows Menu and click on Tile Vertically. The
graphs from all 4 ITMs should appear on the screen.

. Make sure the 4terminal-n-fet Device Plan is plan is highlighted,
If not, click on it only once. (Do not open up the window for the
Device Plan). Click on the green Run button.

. The ITMs should execute consecutively in the order displayed.

. The test can be stopped by pressing the red Abort button.

KEITHLEY
11
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Building a New Project

Executing Multiple ITMs

Results from running multiple ITMs:
_ 5

u-build
g InitializationSteps
ﬁ subsite_a

= WHE terminal-n-fet 0BT - e
VE wdsid

Def\mtiom] Sheet Graph ]5latus] Def\mtion] Sheet Graph ]Status]

BOEO3T
BOE-DEL- oot e
4.0E-03 :
2.06-03 :

=

E

S

&

a

=

1 0E-05
wigs-id
i L 1
(v W subwt
A TOEDE e
:__‘{ TeminationSteps :
QOEAT i ooeomeei e
1.0E13

0.0E+00

-2 0E+00

Dehmtlnn] Sheet  Graph lﬁlatus]

1.5E-02 4.0E-02
3.0E-02
1.0E-02
2.0E-02
5.0E-03
1.0E-02
O.0E+00+ 0.0E+00
o o o o =1 o o o o o =1 o
=1 = =1 =1 =1 =1 =1 =1 =1 =1 =1 =1
T ¥ ¥ T F ¥ ¥ T ¥ T F ¥
w w w w w w w w w w w w
=1 =1 =] =1 =1 =1 =1 =1 =] =1 =1 =1
o - o4 = - w =1 - o4 = - w

B 1 visioti@l [JE vositti@ I wint1@ 1E supwiin@)

MU

KEITHLEY
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Review

What are the Steps in Creating a New Project?

1. Create a new project from the File Menu. F e e |
Name the project.

2. Add a new Subsite Plan. Hlﬁ =

3. Add a new Device Plan.

4. Add anew ITM in one of two ways: ES-O=

e Click on add new ITM button
from toolbar.

« From the Device Plan, choose
test in Test Library and copy to
the Project Navigator.

KEITHLEY
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Review (cont.)

What are the Steps in Creating a New Project?

5. Set up the SMUs in the Definition Tab.

6. Setup the graph inthe Graph Tab (this can also be done
after the project has been executed).

7. Save the Project.
8. Use the green Run button to execute the project.

That’s It!

KEITHLEY
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Performing |-V Sweeps on a Diode —
Building a New project Using an
Existing Library

KEITHLEY

A GREATER MEASURE OF CONFIDENCE © Copyright 2004 Keithley Instruments, Inc.
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Lab 6 Results

[irtcractve Tostwosievd | CRE =1 -SSR =gl &

| x|
Site: 1
| |:| Deflnltlon] Shest Graph lStatus]
= =§ DiodeTest 04/04/2007 14:58:10
= Y13 DiodeMeas ) KEITHLEY
S WD diode 4 0E-11 S Bigde Roverse |_\/Sweep.E.....:....E...._:....E...._:....E.....:....E.....:....E
lﬁ wid . . . . . . . : . . . . . . : : : B B : : : : :
F0E-11
T 20E-11
t
e
5
5]
[l
w0
o
=
o
e q.0E-11
0.0E+00
BT
o o o o o o o O 2 9= = = - T T =T =T = = = = = = = =
(=] [=) {=] {=] {=] {=] {=] {=] {=] {==] {==] [=] o {==] {==] {==] {==] {==] {==] {==] {==] [=] o o o
+ + + F F F F F F F + + + F F F F F F F + + + + +
L w w L L L L L L L w w w w L L w w w L w w w w in}
2 o o 9§ =2 9o 9§ = 9 9 = ™ ™ = W © ~ | ® 9 = o @ = u
- (] L] -+ w w - =] =2 - - - - - - - - - - ™ o o~ (] ™ ™
Reverse Yoltage (V)

16
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Lab 6 Results

(& DiodeTest - Keithley Interactive Test Environment - [vfd#1@1]
lﬁ File ‘“iew Projeck Run  Tools window Help

Interactive Test Module: vid b [?’ @ H a x DCL @ l& @ @
=l
Site: |1
e | |:| Definition] Sheet  Graph l Status]
= ¥I=fE DiodeT est 04/05/2007 09:31:52
= W DiodeMeas ) KEITHLEY
= Mt dode B Comy Diode Forward IV Sweep ™ A TP :

W] LE wrd
W] LE wfd 1.0E-02

1 0E-03

1 0E-04

1.0E-03

1 0E-08

1 0E-07

1 0E-03

Anode Current (L)

1.0E-09

1.0E-10

1.0E-11

10E-12

10E-13

1.0E-14

0.0E+00
1 DE-01
OE-01
3.0E-01
E-01
E-01
£.0E-01
7 0E-01
& 0E-01
9.0E-01

] =] =]
o = o

Fitl[Exp]: p=ae"bu

am+5. 366012 Anode Yoltage ()

b=+2.81e+001

1/b=+3.56e-002

o W £ dode [JE wami@l JE i@

& “1[+2128-2, +3.9%8-2)
[ 2(+750e-1, +3.99-3. 77)

MUIM 17
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Lab 6 Results

By ri g ht CI i Cki ng On the aXiS, (& DiodeTest - Keithley Interactive Test Environment - [vfd#1@1] ‘ZHE|E|

the Axis Properties menu ST LI Ty & | o
opens. The axis scale can o — o pep !
be changed here. In this e S Dl Forvard H Swesp ,
example, the scale is o - . g
Changed to 1e-6 to match B O SO St DS SRS PROS PRSPPSO
the spec sheet graph.
£ :
Axis Properties E| é :
i e | T s
Title St
Test |Anc-deEurrent[A] 10505
Rotaton (a0 | Max
duto T |abs| 106051 - i - - i pa pa : L
fucbvanced Properties ‘ Irvert T T
iow fr cdode |LE waf@ LE  vidi@
-

KEITHLEY
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Managing KITE

Application Files and Test Results

Default user directory —» C:\S4200\kiuser

51 Exploring - C:\54200\kiuser
File Edit Yiew Toolz Help

The default user directory is

. _ : [ Kiuser = alwl 4B o XE EEEE
Cal I Ed kl user. Th IS d Irecto ry | &1l Folders | Contents of 'T:45 4200 kiuser
. . . . @ Desktop Marne | Size | Tupe | Modified |
contains four subdirectories: =S8 My Computer Cl Devices File Folder 4/26/00 427 PM
"Q 3% Floppy [A:] [ ] Projects File Falder 8/8/02 316 P
. =& 4200-scs () [0 Tests File Folder 2/602 1156 &M
° DeVl C es g i’;om (2 usrlib File Folder 4/26/02 7:02 PM
. -] Cabs
i P r OJ eCtS {:l cascade
-0 Cecdas
hd TeS t S {:I fleslnn
. D Praagrarn Files
° usr“b =7 54200

=0

E.

| . B0 Devices
(7] Projects
L WO Tests

] ualib
DN
E-L Temp
[]-& unzipped
B+ Wxlprp
-0 winnt
B (D)

-.[&] Contral Pansl
-] Printers

(@] Scheduled Tasks
-2 Metwork Neighborhood
----- fﬁ Recycle Bin

< |

|4 object(s] [plus 1 hidden) |D bytes (Disk free space; BFFMEB]

|

19
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Managing KITE

Application Files and Test Results

Devices Subdirectory

» By default, the Devices subdirectory contains the KITE device library
that is provided with each version of KITE.

« Users can copy devices from this library to their projects or submit
devices from their projects to this library.
- [5]

:*l
GBack M > ) l'ﬂ? /.ﬂj Search ‘[F‘ Folders‘ FFH

Address |ui1 4542004 user Devices \Capacitor . i | 0 g E a.C h d eVI C e IS d efl n e d

Folders [\Jame Size | Type Dat
X |*) capacitor bmp 1KB Bitmap Image 972t -
1,
j’ st Flupp?’ @ A B capacitor kv LKB KDV File B/at b th re e fl I eS
= % Chrive () [*) capacitar-big.bmp 6KE Bitmap Image 2420 "

1) acroldr
I Documents and Settings
I3 Program Files

|) RECYCLER.

i  New devices can be
2 S created by a bitmap
editor, such as

S Microsoft Paint.

1) Resistar
1) export
= ) Projects
) AFP-BITcells-C021
2 #KS
IE3) chargepumping
|23 chargetrapping
= 153 default

KEITHLEY
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Advanced KITE

Creating Custom Devices in KITE

File Edt Seach Help

[[Bitmaps] 2]
Small=8terminal-Generic.bmp
Big=8terminal-Generic-Big.bmp

[Terminals]

Humber=8
Orientation=;H:A;HE:B;E:C;SE:D;S:E;SW:F;W:G;HW:H

Custom devices can
be created using
Microsoft Paint.

[

KEITHLEY
21
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Application Files and Test Results

Projects Subdirectory

The Projects subdirectory contains the default KITE project library
that is provided with each version of KITE.

By default, users store KITE projects in this directly. However,
projects can be stored in any location using the File - Save Project
As menu.

Projects consist of multiple files stored in a pre-defined directory
structure. All of the project components are stored in a project folder.

Projects can be moved from one location to another as long as the
entire project folder — with all of its contents — are relocated.

Projects can be emailed, but the entire projects folder must be
Zipped.

KEITHLEY
22
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Managing KITE

Application Files and Test Results

/

5‘ E xploning - C:AS42000kiuser\Projects\DefaulATES T5\data
File Edt “iew Toolz Help
[ data - Bl gl dsrl o XE BEEE
|.~'1'«|| Folders | Contents of 'C:AS42000kiuzerProjectshDefaul s TEST 54 data'
lﬁ Desktop A | Mame | Sizel Type | Modifiec «
=12 My Computer caphl @1 kgs 7EE  KGS File 4/25/01
=3 3% Floppy [4] 3] cap1 @1.4s T1KE  Microsoft Excel Wor..  4/25/01
== 4200-¢cs L) gianlucat1 @1, $kgs KB $KGS File 345402
- 3com Gummelt @1 kgs 7B KGS File 4/23/01
:g E;‘bs @_gummeuﬂ @1 x5 12KB  Microsoft Excel Wor...  4/23/01 Shown here
I , ig-wgi1 @7 ks KB EGS File 719,02
+|- Ccascade @ . .
: igvgt @18l 15KB  Microsoft ExcelWor..  7/19/0: are the d ata
(] Cecdnn
% _ | o] res 2ttt @t kg 7KE  KGS File 4425101
' 2L s T1EE  Microsoft Excel Wor...  4/25/01 I
-7 Program Files @res I:”]
=07 54200 [3#] subvttl @1 $kgs TKE  $KGS File 7907 flleS from
&-3 hei (28] subrvtt @1, $uls 15KE  $LS File 7A1940: the Defau|t
|__—_|D kiuser subyt1E1 kgs KB KGS File 72190z
D Devices @suhvtiﬂ 2 uls 15KE  Microsoft ExcelWor...  7413/0: roect
=-E3 Sweepdl 1481051 kos BKE  KGS File 441040z p J .
@Sweepaﬂdm 2. ulz BB Microzoft ExcelWor.. 440402
{:l devices testﬂ'l @ kgs EEE K5 File 472602
(0 subsites B8] test1 @1 s BKB  Microsoft Evcelwor..  4/26/0
=0 Tests < vce-ic#1@1.kgs 7KE  KGS File /2301~ ]
- 4 »
[Dizk free space: 67 ME] 4

Default project folder includes three files: devices, subsites, and Tests.

A . GREATER MEASURE OF CONFIDENCE
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UTM (User Test Module)

« AUTM Is a user-named test module that connects to,
configures and runs a KULT created user module.

« UTMs may be used to run special parametric tests that
cannot be performed with existing ITM functions.

« They may be used to control external instrumentation,
such as a CV meter, switch matrices, etc.

* KITE includes user libraries containing pre-coded user
modules for several commonly used external instruments.

e Using KULT, you can also write code to create custom
user-modules in C.

KEITHLEY
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Inserting a New UTM

1. Select the device in which to insert a new UTM name.

\

. Projec\T ][]
2. Add a new UTM using the Add E_’?;;g\ — -
InitializationSteps ]
New UTM button. s e X
=Nt dterminal-n-fet 1
= = (@) | e 1
- A\E wdsid 2
EI-IE- terminal-n-fet-2nd_in_subsite 1
3. Enter a new UTM name. o |, vdsid? 1
- 0
Add New User Tezt Module [UTHM] to Project | 2
. . 1
M charg_char 1
Mew UTH Mame: -_L=,{ T erminationS teps 0
|res_drain-tn:u-3n:nurn:el
" Befare selected node ¥ After selected node
ak. LCancel |
KEITHLEY
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Inserting a New UTM (cont.)

4. Click on the new UTM in the Project Navigator
and choose a User Library.

Action
-~
Create a new UTM
called test in the
project you have
currently open

Select the BeepLib.

A . GREATER MEASURE OF CONFIDENCE

[E1 File Wiew Project Run Tools Window Help -8 X
User Test Module: test [ e & HE ¥ & % E B @
x|
Site: 1 |:
e Defintion | Sheet | Graph | Status |
Offset_Current
= % Open_Circuit User Libraries: |BeEDle j
- ol Copped Input S —— — _
WILE Meas . Output Yalues | User Modules: c:algepumping
chargetrapping
Pl test 500 Hotchuck_T emptronics 30108
Hatchuck_Triatek.
Name HP4284ul
HP4234ulib
1 feauency sy
2 duration | iseb
3 K142l
4 KI530ulib
5 KI535uly
Klg2ulb
6 kipulseulib
i kiscopeulit
8 Matrisuli
parlib
9 pivulib
10 prboen
Pulsely W
11
12 hd
HAME : been A
DESCRIPTION This function is & wrapper around
the Windows HT API Beep function
PARAMETERS The first parameter specifies the frequency, in hertz, of the sound
This paramster must be in the range 37 through 32.767.
The =zecond parameter specifies the duration, in millisecond=. of the sound
RETUEN WALUE: If the function succeeds. the return valus is non-zero
If the function fails, the return value is zero
LIBRARIES
Dependencies: Kernel3Z.lib v

- Pigjectiiew

U4 Meas Cure...| ¥ Capped Input €] testti @i

KEITHLEY
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Inserting a New UTM (cont.)

5. Choose the desired User Module.

6. Modify the test parameters as desired.
7 . Save th e P roject. sCtKleertive Test Environment - [test#1@ 1]

User Test Module: test (=3 e @+ B x & ? M = @
x|
e I = Defiritian | Sheet | Graph | Status |
= W=f8 Offset_Cument
= W Open_Circuit User Libraries: ‘Eeepuh j
= W0 Capped_Input
WUE Mo C.. Dupavihes| smiates ooy
. test been i
g s a00 BeepCharge
ction
Name EeeplnfiniteLoop
frequency  |BespUp
{} duration T Input_ [ONG 500 5

» Select the beep
User Module. ;

« Save the Project. -

DESCRIFTION Thi= function is a wrapper around
the Windows NT AFI Beesp function

FARAMETERS.  The first parameter specifies the frequency. in hertz, of the sound

5 This paraneter must be in the rangs 37 through 32,767
» Click on the green e smcot pcasmtar sgacims the dation. 5n wiLlsssconds. of e s
RETURN VALUE TIf the function succssds, the rsturn valus is non-zero
Ru n b u tto n Tf the function fails, the return value is zero
- LIERARIES
Dependencies: Kernel3? lib

" = Proiscivien JE Meas_Cune [ £ Capped_Inpul [€]  testii1 @1

urrent - K. s 350 PM

KEITHLEY
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Understanding a UTM

Graph tab: Status tab: User libraries: User modules:
Graphical testand  Test definition and Select the user library Select the desired

Sheet tab: analysis results. configuration status.  that contains the desired  module for the UTM.
Numerical test and analysis \ \ m&dule. /

results and test settings. e / /
Formulator: ] vertier oo™ =" =
Mathematlcal test £ Output Values User Modules: |E0nnectF’ins <« j
results analysis tool. [ X
Name In/Out Type N\ Value =
Output Values button: 1 OpenAll Input Nt i N |
. . 2 TermldStrl Input CHAR_F Shil1
Click to export Output Values for this 3 Pint input INT |3
. . 4 TermldStr2 Input CHAR_F SMUZ
test into the Subsite Data sheet. 5 Pir2 opu—> T4
| ——TETmd 5t Input CHAR P |3MU3
. . . ‘/- in npu
Parameter identity cells: - Terrpn_|d351r4 :nEu: e Ssmua\
Spreadsheet-like cells that list the test : e R \C §
module parameter names and data e .
types, as specified in the user module. i e e o s e it
Bk anistion i e (nt it i
Workspace window tab: By ey B BT 12T BT
You can quickly access a Project- | e .
component window that is active in the
Ny
KITE wc_)rkspace — several can be_ _ e p— /' ‘\
active simultaneously — by selecting its / \
Workspace tab. Documentation area: Parameter entry cells: Cell display edit box:
Displays information about Enter test-parameter Display enter contents of

the user module. values in these cells. selected cell.
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Help Menu

o [

4200-5CS Complete Reference F1

¥ about KITE...

Help —» 4200-SCS Complete Reference

4200-5CS Complete Reference loads the 4200-5C5S Complete Reference portable web site,
which is prainstalled on your 4200-5C5 and included on CO-ROM. It was specifically designed fo
provide easy access to all Model 4200-5C5 reference information, such as:

Product Manuals — The 4200-5C5 User Manual, the 4200-5C5 Reference Manual, and
related product manuals in searchable .pdf format.

« Data Sheets — The Model 4200-5CS Technical Data Sheet and related product data
sheets.

Application Notes — Fragmatic examples of how to use the Model 4200-5C5, and related
products, to perform application specific tasks.

Selecting Help —> 4200-SCS Complete Reference automatically starts the web browser and
loads the Complete Reference web site.

Help —» About KITE
Provides the internal version of KITE.

KEITHLEY
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